Austin Peay State University, Tennessee Fall 2015
CSCI 3300: Introduction to Web Development
Dr. Leong Lee

CSCI 3300 Assignment 6

Total estimated time for this assignment: 9 hours

When you see “Richard Ricardo” in the example screen captures, change it to <your name>.

When you see “Richard” in the example screen captures, change it to <your first name>.

If you do not put <your name> / <your first name> in the above mentioned fields, you will get 0 points for
the question(s).

No two students should submit webpages with exactly the same code, or same content, or same layout, or
same color combination. If found, both students will get 0 points.

Create a folder on your hard disk, name the folder lastname_firstname_assignment6. Save all the files from
this assignment in this folder.

Create the following subfolders (in the folder lastname_firstname_assignment6): g1, g2, g3.

As a result, you should have the following folder (directory) structure for this assignment: (-2 points if wrong)
o lastname_firstname_assignment6\q1\
o lastname_firstname_assignment6\q2\
o lastname_firstname_assignment6\gq3\

Use Firefox Web Console (Tools > Web Developer > Web Console) to help debugging JavaScript. All html
(JavaScript) files must pass JavaScript validation at Firefox Web Console without any error, without any
warning (-2 points for each error, each warning).

e Turn on your Firefox Menu Bar (Hint: right-click).

o  Make sure your Firefox is up to date (Help > About Firefox).

e Turn on Web Console when you code (Tools > Web Developer > Web Console).

e Fix any error/warning immediately when you see them. Do NOT accumulate errors.

When you view page source in a web browser, <!DOCTYPE html> must be at the top of every page. In
other words, all pages must be written in HTMLS5. (-20 points if not)

Question 1 — JavaScript Chapter 5 (33 points) Estimated time: 3 hours
e Save question 1 files in subfolder “lastname_firstname_assignment6\q1\”. (-25 points if no JavaScript)
o Create a web page that displays the default information (example shown). (1 point each, total 3 points)

e The initial page and related outputs should look like the examples shown below.

e Create your page using “<your name>’s Kung Fu Panda Po Odd and Even Log” as the page title. Save
the page as index.htm. Remember to document the html file with html comments. (1 point each, total 3
points)

e Write a program that asks the user for Po’s meditation numbers.

o The user should be allowed to enter as many data set as desired (or enter -999 to quit). (4 points)
o You must use do...while or while loop. (-15 points if not)
o The output should look like the example output shown. (1 point each, total 3 points)
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o Indicate if an entered number is odd or even. (6 points)
o The program should output the number of odd numbers entered, their sum and average. (6 points)
o The program should output the number of even numbers entered, their sum and average.(6 points)
o Create a css file named style.css to format index.htm by creating your own layout (no two students should
have the same layout). Use css comments to document the css program. You can use the same (or similar)
css file(s) to format all questions. (1 point each, total 2 points)

Example: Initial Page

hard Ricardo's Kung Fu Panda
) Odd and Even Log

Click on the button to enter Po's meditation numbers.

Richard will keep track of odd and even meditation numbers.

Richard's Po meditation numbers

Po's Meditation Numbers:

Example: Input

Enter an integer (or enter -999 to quit) Enter an integer (or enter-393 to quit)

i — a

[Eoca] (G [ox | [ ol

Enter an intager (or enter -999 1o quit)
23

[ok ] [ camen
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Enter an Integer (or enter -999 to quit): Enter an integer (or enter -999 to quit):
15 ]

[ ok ][ cancer [ ok ]| cancal

Enter an integer (or enter -999 to quit)
089
] Preventthis page from creating additional dialogs

| | Cancel

Example: Output

lichard Ricardo's Kung Fu Panda
)dd and Even Log

Click on the button to enter Po's meditation numbers.

Richard will keep track of odd and even meditation numbers.

Richard's Po meditation numbers

Po's Meditation Numbers:
14 is even

20 is even

23 is odd

34 is even

15 is odd

8 is even

You entered 2 odd numbers.
The sum of these numbers is 38.
The average of these humbers = 38 / 2 = 19.00

You entered 4 even numbers.
The sum of these numbers is 76.
The average of these numbers = 76 / 4 = 19.00
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Question 2 — JavaScript Chapter 5 & 6 (33 points) Estimated time: 3 hours
e Save question 2 files in subfolder “lastname_firstname_assignment6\q2\”. (-25 points if no JavaScript)
o Create a web page that displays the default information (example shown). (1 point each, total 3 points)
e The initial page and related outputs should look like the examples shown below.
e Create your page using “<your name>’s Kung Fu Panda Po Magic Rectangle” as the page title. Save the
page as index.htm. Remember to document the html file with html comments. (1 point each, total 3 points)

e Write a program that asks the user for Po’s row and column numbers for generating magic rectangles.

o Use html text fields (<input type="text™ .. >)to capture row and column numbers. (4

points)
o Generate the magic rectangles shown using nested loops (two-dimensional loops).
o The first rectangle must be generated by nested for loops.

for (..)
{
for (..) {}
} (6 points for logic, 4 points for output formatting)
o The second rectangle must be generated by nested while loops.
while (..)

{
while (..) {}

} (6 points for logic, 4 points for output formatting)
o The third rectangle and related calculation must be generated by nested do...while loops.
do

{
do {} while (..)

} while (..) (6 points for logic, 4 points for output formatting)
e Create a css file named style.css to format index.htm by creating your own layout (no two students should
have the same layout). Use css comments to document the ¢css program. (1 point each, total 2 points)

Exale: Initial Page

Richard Ricardo's Kung Fu Panda
?0 Magic Rectangle

Enter Po's row and column numbers.

Po's row: | ]
Po's column: [N

generate Po's magic rectangle

Po's Magic Rectangle:

Example: Input

Richard Ricardo's Kung Fu Panda
) Magic Rectangle

Enter Po's row and column numbers.

Po's row:
Po's column:

generate Po's magic rectangle

Po’'s Magic Rectangle:
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Example: Output

Richard Ricardo’'s Kung Fu Panda
0 Magic Rectangle

Enter Po's row and column numbers.

Po's row:
Po's column: BN

generate Po's magic rectangle

Po's Magic Rectangle:
Po's magic rectangle has 3 rows, and 5 columns.

Nested for loop rectangle
FFFFF
FFFFF
FFFFF

Nested while loop rectangle

W,row1i,coll; W,rowl,col2; W,rowi,col3; W,row1l,col4; W,rowi, col5;
W,row2,coli; W,row2,col2; W,row2,col3; W,row2,col4; W,row2,col5;
W,row3,coll; W,row3,col2; W,row3,col3; W,row3,col4; W,row3,col5;

Nested do..while loop rectangle

1x1=1; 1x2=2; 1x3=3; 1x4=4; 1x5=5;
2x1=2; 2x2=4; 2x3=6; 2x4=8; 2x5=10;
3x1=3; 3x2=6; 3x3=9; 3x4=12; 3x5=
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Question 3 — JavaScript Chapter 5 & 6 (34 points) Estimated time: 3 hours
e Save question 3 files in subfolder “lastname_firstname_assignment6\q3\”. (-25 points if no JavaScript)

o Create a web page that displays the default information (example shown). (1 point each, total 2 points)
e The initial page and related outputs should look like the examples shown below.

e Create your page using “<your name>’s Kung Fu Panda Po Weekly Training Log” as the page title. Save

Example: Initial Page

Example: Input

the page as index.htm. Remember to document the html file with html comments. (1 point each, total 3
points)
Werite a program that allows the user to enter Po’s training hours for each day and each week.

o Use html text fields (<input type="text" .. >)to capture the number of weeks and the
number of days per week. (4 points)

o The user should be allowed to enter the training hours for each day of each week.

o The output should look like the example output shown. (1 point each, total 3 points)

o The program should also calculate Po’s total training hours, subtotal training hours for each
week, and the day with the largest number of training hours for each week. Your output should
follow the example output format given. (3 points each, total 12 points)

o You must use nested loops (for, or while, or do..while or mixing them) to solve the problem.
(-15 points if not)

Create a css file named style.css to format index.htm by creating your own layout (no two students should
have the same layout). Use css comments to document the css program. (1 point each, total 2 points)

rd Ricardo’'s Kung Fu Panda
eekly Training Log

Number of weeks Po trained: ]

Number of days Po trained each week: I

chard Ricardo's Kung Fu Panda
Neekly Training Log

Number of weeks Po trained: 2 ]
Number of days Po trained each week:

Enter Po's weekly fraining hours

Enter the training hours for week 1, day 1:

[s4

oK Cancel

Enter the training hours for week 1, day 2
5

Enter the training hours for week 1, day 3

[k ]| cancel
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Enter the training hours for week 2, day 1:
[ Enter the training hours for week 2, day 2:

[79

oK Cancel

Enter the raining hours for week 2, day 3
65

Example: Output

hard Ricardo’'s Kung Fu Panda
‘Weekly Training Log

Number of weeks Po trained:
Number of days Po trained each week:

Enter Po's weekly training hours

Po trained 2 weeks, and he trained 3 days per week.

Week 1

training hours for day 1 = 5.5 hours

training hours for day 2 = 5 hours

training hours for day 3 = 6 hours

Week 1 subtotal is 16.5 hours

Week 1's largest day training hours is 6 hours, happens on day 3.

Week 2

training hours for day 1 = 7 hours

training hours for day 2 = 7.5 hours

training hours for day 3 = 6.5 hours

Week 2 subtotal is 21 hours

Week 2's largest day training hours is 7.5 hours, happens on day 2.

The total training hours for these weeks = 37.50 hours
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Important:

1. If you do not put <your name>/ <your first name> in the above mentioned fields (as shown in the
examples), you will get 0 points for the question(s).

2. No two students should submit webpages with exactly the same cod, or the content, or same layout, or
same color combination. If found, both students will get O points.

3. When you view page source in a web browser, <!'DOCTYPE html> must be at the top of every page. In
other words, all pages must be written in HTMLS5. (-20 points if not)

4. All html files must pass html validation at http://validator.w3.org/ without any error/warning (with only 2
warnings). Use the validator’s “File Upload” tab to check each file. (-2 points for each error/warning, 2
warnings allowed)

5. All css files must pass css validation at http://jigsaw.w3.org/css-validator/ without any error/warning. (-2
points for each error/warning)

6. If your html file contains any css component, your html file must pass both html validation (3 above), and
css validation (4 above) without any error.

7. If your files do not pass the validations, 2 points will be deducted for each error (and each JavaScript
warning) found.

8. Document (comment) your html files (<!-- -->), css files (/* */), and JavaScript files (/* */). (-1
point for each file with insufficient comments)

Submission instructions:

e You need to test the above document(s) in your web browser.

e Do screen capture(s) of the initial page and the related output(s). Use any graphic editing software (e.g.
Microsoft Paint, Adobe Fireworks, GIMP, or Microsoft Expression Design etc) to cut out the browser
output (from the screen capture), paste them into a word document.

e For this assignment, you only need to do screen capture(s) of the initial page and the related output(s),
you do not need to do screen capture(s) of the input pages. Provide 2 different test cases for each question.
In other words, for each question, you need to have 1 initial page screen capture and 2 related output(s)
screen captures. (-50 points for no test cases, -5 points for only 1 test case)

o Do screen capture(s) of html validation results and css validation results, cut and paste them into the word
document. You do not need to do screen capture(s) of JavaScript validation results.

e Save the word document as a pdf file.

You need to submit the following:
1. A pdf file containing the screen capture(s) of the web browser output (all html pages) and the screen
capture(s) of all html validation results (from http://validator.w3.org/) and css validation results (from
http://jigsaw.w3.org/css-validator/), name the file lastname_firstname_assignment06.pdf.
2. All html file(s), css file(s), and other related files (e.g. image files). Zip your file folder
(lastname_firstname_assignment6) into a single zip file (or rar file) lastname_firstname_assignment06.zip.
In the above example, the zip file should contain the following files and subfolders. If there is any image, there
should be a\images\ subfolder.

o lastname_firstname_assignment6\g1\index.htm
lastname_firstname_assignment6\ql\style.css
lastname_firstname_assignment6\g2\index.htm
lastname_firstname_assignment6\g2\style.css // you may put style.css in a subfolder
lastname_firstname_assignment6\g3\index.htm

o lastname_firstname_assignment6\q3\style.css
Please submit an electronic copy (the above mentioned two files: .pdf and .zip) to D2L digital dropbox.

Grading guidelines (programming questions):
Your programs will be judged on several criteria, which are shown below.


http://validator.w3.org/
http://jigsaw.w3.org/css-validator/
http://validator.w3.org/
http://jigsaw.w3.org/css-validator/
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e Correctness (50%): Does the program compile (run) correctly? Does the program do what it’s
supposed to do?

Design (20%): Are operations broken down in a reasonable way (e.g. classes and methods)?

Style (10%): Is the program indented properly? Do variables have meaningful names?

Robustness (10%): Does the program handle erroneous or unexpected input gracefully?
Documentation (10%): Do all program files begin with a comment that identifies the author, the
course code, and the program date? Are all the classes, methods and data fields clearly documented
(commented)? Are unclear parts of code documented (commented)? (Some items mentioned may
not apply to some languages)

A program that does not compile (run) will get at most 50% of the possible points.



